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INSTRUCTOR NOTES

Getting Started
Th e Adobe® Fireworks® CS4 Classroom in a Book® course presents students with 
tips, techniques, and solutions for using the Adobe Fireworks CS4 software.

Th e Instructor Notes are intended to complement the information in the Adobe 
Fireworks CS4 Classroom in a Book®. Th e information is organized to follow the 
sequence of instruction in each lesson. Th ese notes are not a play-by-play of each 
subsection of the book; rather they point out specifi c areas where we feel you can 
expand on the lesson, or perhaps introduce tangential subjects that may not be 
covered in the text.

Course strategy
If you’re teaching a 15-session class, you can teach approximately one chapter of 
this book per class. Th e book contains 11 lessons, plus two supplemental lessons on 
the companion disc, some of which may take a while to complete. If you are teach-
ing a 10-session class, you may want to combine some of the lessons in a single 
class. For example:

• Lesson 1 is focused on learning about the Fireworks user Interface.

• Lesson 5 covers the Layers panel in detail. Th is is a very important panel in 
Fireworks and crucial to almost any but the most basic work in Fireworks.

• Lessons 2 and 3 cover related aspects of photo retouching and bitmap selections.

• Lesson 4 is about working with and creating vector objects. Also, Lesson 6 
covers eff ects that are based on masking using both vector objects and bitmap 
selections. Lesson 7 focuses on working with text.

• Lessons 4 and 9 deal specifi cally with layers, although layering is a crucial 
element in almost every lesson following Lesson 4.

• Lesson 8 is an in-depth introduction to creating web objects, optimizing images 
for web use, and exporting fi les for use in HTML-based prototypes.

• Lesson 9 is focused on the three diff erent types of symbols you can create 
within Fireworks. Symbols can save you time and fi le size because they can be 
used over and over again within a fi le, and because editing symbols aff ects all 
children (instances) of a symbol that are in a design.

• Lessons 10 and 11 are focused on creating interactive prototypes. Lesson 10 begins 
with an in-depth discussion of the Pages feature in Fireworks and ends with the 
student exporting an interactive PDF fi le. Lesson 8 should defi nitely be covered 
before moving to these lessons, as web objects are used in both lessons 10 and 11.
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• Lessons 12 and 13 (found on the companion disc) take the student beyond the 
basic functionality of Fireworks and cover topics such as using Adobe Bridge, 
batch processing, adding metadata to fi les, and working with other applications 
such as Photoshop, Flash, Dreamweaver, AIR, and Flex.

Managing student projects
One way to simplify fi le storage and retrieval in classroom situations is to ask 
students to create a folder on their hard disks, name it [Student’s, for the student’s 
name] Lessons, and then copy each project folder into the main Lessons folder. 
Having students keep all their working fi les in their own Lessons folder makes it 
easy for you to clean up fi les when a class is over.

Lesson 1: Getting to Know the Workspace
Th e fi rst lesson presents an introduction to the Adobe Fireworks CS4 software.

Using the basic commands, tools, and panels, your students will learn general tech-
niques for using the work area effi  ciently, obtaining information about the image 
in front of them, and selecting tools or entering values to change the image. Th is 
lesson also introduces students to the History panel, a valuable tool in undoing and 
stepping backwards in their work.

Goals for this lesson
How much time you should schedule for this lesson depends on whether your stu-
dents already have any knowledge of Fireworks and on their computer skills in gen-
eral. Th e overall objective for Lesson 1 is to make them suffi  ciently familiar with the 
user interface so that they can locate the controls they need to do the procedures in 
the rest of the lessons. Additionally, by learning how to help themselves, they gain 
confi dence and independence. In general, they should be able to do the following:

• Identify and name the key areas of the interface, including the Tools panel, 
panels (in general), document windows, and the Property inspector.

• Open the main menus and submenus across the top of the work area (File, Edit, 
and so forth), context menus, and panel menus.

• Access and search Adobe Community Help, which includes the full Fireworks CS4 
Help, as well as links to other Adobe and third-party Fireworks resources online.

Finding tools in the work area
You may want to introduce students to the Fireworks environment by providing a 
general tour of the work area. Th is helps orient the students and provides a review 
of the names of the elements on the screen. For example, you may point out the title 
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bar and remind students that it indicates which document is currently active. Th en 
point out the menu bar, the rulers, the page icons, the panels, and the Tools panel.

Students may already be used to keyboard shortcuts as a simple alternative to using 
the mouse. Fireworks and other Adobe products allow you to combine keys with 
mouse clicks to perform tasks quickly.

Many Fireworks professionals keep one hand on the mouse and the other over 
the keyboard to switch tools and modes. You may want to demonstrate how this 
method allows you to keep the pointer directly over the part of the image that 
you’re editing.

Encourage students to use commands at fi rst, so they understand what they’re 
doing and how it relates to the application. As they become more comfortable with 
the tools and concepts, remind them that shortcuts can help them accomplish 
tasks more quickly.

Using the application frame and the application bar
New to Adobe Creative Suite 4 are the application bar and, in Mac OS, the applica-
tion frame. By default, the application bar is enabled and the application frame is 
not. Some lessons include steps that use the application bar, so it’s best for students 
to leave it visible, though they may prefer to hide it when they work on their own.

If your students are working in Mac OS, suggest that they enable the application 
frame to minimize distractions from other applications and items on the desktop. 
If you reset preferences at the beginning of each lesson, you’ll need to enable the 
application frame each time.

Viewing designs
Double-clicking the Zoom tool displays one image pixel for each monitor pixel. 
Th is magnifi cation displays an image at exactly the same size as it will appear in a 
web browser. But because monitors can be set to diff erent resolutions, the real size 
of an image viewed in Actual Pixels view or in a web browser will vary depending 
on the monitor in use.

Point out that you can also change magnifi cation of a design by choosing a Zoom 
level in the Application bar or from the Zoom level in the document window at the 
lower-right corner.

Many users are unaware that the monitor resolution can be changed so you may 
want to demonstrate this. Increasing the resolution makes more room for panels 
and images on the screen, but with the trade-off  of making everything smaller.

Finally, you may want to demonstrate how to see a single image at two magnifi ca-
tions simultaneously. To do so, choose Window > Duplicate Window and then drag 
the tab of the new window to the left or right side of the document area to show 
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both views at the same time. You can zoom into one view to make detailed changes 
while viewing the full image in another window to see the changes in context.

Using the Property inspector and panels
Students should understand that the Property inspector is not the same as the tool-
bar (or button bar) found in products such as Microsoft Offi  ce. In Fireworks, the 
controls that appear on the Property inspector change depending on the selected 
tool. Similarly, the Property inspector cannot be customized because it always 
represents options for the current tool. Take care to refer to the Property inspector 
by its complete name and not as a “toolbar” or “button bar”.

Using the History panel
You can use the History panel simply to undo steps, or to automate certain work-
fl ows by replaying history steps. Make sure students understand that history states 
aren’t saved with the document. You can suggest that if students want to keep 
diff erent versions across sessions, they should set up a design as separate pages or 
documents instead.

To supplement the information in this section of the book, you can tell students 
about the Save Steps as a Command feature in the History panel menu. Th is lets 
the student save a series of history steps as a JavaScript command, which they can 
invoke from the main Commands menu any time they wish. Point out that they 
can use this feature by selecting a series of history steps generated from menu or 
keyboard commands (steps such as moving objects on the canvas with the mouse 
cannot be saved as part of a custom command) and then choosing the Save steps as 
a Command icon. 

Confi guring panels and the panel dock
Th e Tab keyboard shortcut lets you hide all panels instantly, so that you can quickly 
evaluate designs without distraction. When you’re working on a small screen, it 
also lets you use the entire screen to edit images. Th e Tab key returns the panels 
just as quickly.

Th e F key will cycle between diff erent workspace views (Standard view, Full screen 
with menus and panels, and Full screen). In Full screen view, mousing over any of 
the four sides of the workspace will reveal the panels in that area.

Show students how easy it is to collapse panels to icons, and then expand the pan-
els again with a click. In this lesson, students will look at customizing a workspace. 
Th ey will defi ne a custom workspace in Fireworks that shows and hides specifi c 
panels, based on the type of task they are performing.

You do not need to go into this feature in-depth now, to avoid the risk of informa-
tion overload in the fi rst lesson.
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Using a context menu
While not covered as a specifi c section in this lesson, demonstrate how context 
menus change depending on the content under the pointer. Right-click (Windows) 
or Control-click (Mac) the following examples:

• Diff erent layers

• An active object on the canvas

• Text with an insertion point

• In any list panel

If your students use graphics tablets, encourage them to program their stylus but-
ton to display context menus.

Using Fireworks Help
Choosing Help > Fireworks Help opens Adobe Community Help, which includes 
the entire Fireworks Help, as well as links to other online resources. Show students 
that Fireworks Help includes access to a variety of tutorials, both written and in 
video format.

Using Adobe Online services
Students may inquire about privacy concerns related to the Adobe Online service. 
You can reassure them that no personal or confi guration-related information is 
sent from their computer, except that which is explicitly typed in by the user as 
part of the voluntary online registration process.

Questions
Th e following questions are not in the student’s Classroom in a Book.

1. What do you do if you can’t fi nd a tool that you know exists?

2. How can you fi nd the keyboard shortcut for a tool?

3. How can you instantly hide or show all panels?

4. What are other ways to switch to a specifi c preset zoom percentage?

5. What magnifi cation is the best representation of an image’s size on a web page?

6. How do you view multiple documents at the same time?

7. What is the diff erence between a panel and a document window?
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Answers
1. Look in the Tools panel for a related tool with a small black triangle. Th at 

triangle symbol indicates that holding down the mouse button on that tool 
opens a list of hidden tools at that location.

2. Hold the pointer over the tool until the tool tip appears containing the keyboard 
shortcut for that tool.

3. Press the Tab key (when you’re not editing text).

4. Choose the zoom level from the Application bar or from the lower-right corner 
of the document window.

5. 100%

6. Undock a document by dragging its tab away from the tab bar. Th en drag the 
title bar of the document to any of the four sides of the main document window. 
When a blue highlight appears, release the title bar.

7. A panel contains a set of related controls that you select and use to work on 
your document. You can have many panels open, group them, hide them, and 
separate them. Th e document window displays your design. If you close a 
document window, you close that fi le.

Lesson 2: Working with Bitmap Images
Th is lesson introduces learners to working with and editing bitmap images. 
Fireworks works equally well with vectors and bitmaps, and becoming aware of this 
fl exibility is important to realizing the full potential of Fireworks.

Th e basics of opening, importing, cropping, and retouching images will be covered 
in this lesson.

Goals for this lesson
With the solid set of Bitmap tools in Fireworks, there will be many situations where 
the user can work entirely within Fireworks without having to switch to other 
applications. Th e overall objective of this lesson is to familiarize users with these 
tools and give them insight into how images can be retouched using bitmap tools 
such as Dodge and burn or the Rubber Stamps, or in a non-destructive manner 
using Live Filters.

 In general, they should be able to do the following:

• Identify and name the key bitmap tools

• Import images into an existing design

• Non-destructively alter an image using Live Filters
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• Repair images using the Rubber Stamp

• Resize images

In addition, there is an exercise that introduces the new 9-slice scaling tool where you 
can show users how to scale certain types of bitmap images in one direction with no 
distortion. Th is feature was previously only available for symbols in Fireworks CS3.

Resolution and image size
Point out the relationship between image resolution and fi le size, and also how 
a high-resolution image does not necessarily mean a high quality image. Cheap 
digital cameras, poor quality scans, or highly compressed images can produce a 
high-resolution, yet poor quality image.

Encourage the students to resample images and see what happens to fi le sizes.

Cropping 
Fireworks can crop an entire design or specifi c bitmaps within a design. Show how to 
quickly apply the cropping marquee to an entire image by double-clicking on the tool.

Point out that cropping a design does not have to be destructive; you can set crop-
ping preferences within the Preferences panel.

Managing images on the canvas
Complex designs tend to contain multiple images. Point out that Guides, tool tips, 
Smart Guides, the keyboard, Pointer tool, and the Property inspector can all be 
used to help position objects precisely on the canvas.

While not mentioned in the book, users can also set up a Grid to help align objects.

Demonstrate how to activate tool tips and how Smart Guides can help align objects 
to each other or to the canvas. Point out that snapping can be activated for Smart 
Guides, Grids, and Guides, and that the snapping distance can be adjusted within 
the Preferences panel.

Importing an image
Importing images is an often overlooked but powerful feature. Th e exercise on import-
ing images demonstrates how you can quickly add a fi le to a currently open document 
and throughout the book your students will call on the Import feature regularly.

Mentioned in the book is the importance of not scaling an imported bitmap larger 
than its original size. While there is no specifi c exercise to demonstrate this, have 
the students import the watch_colors.png fi le and scale it wider than the currently 
open document to show how bitmap images will be aff ected when enlarged.

Encourage students to import other fi les to the document and experiment with scaling.
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Distortion-free bitmap scaling with the 9-Slice scaling tool
Th e 9-slice scaling tool is new to Fireworks CS4 and gives you the ability to scale 
rectangular vectors and certain bitmaps without having to convert them to symbols. 
In this lesson, the students scale a photograph to widen the image. 

9-slice scaling is only eff ective on bitmaps that have areas that will not be aff ected 
by scaling in a single direction. Th e exercise provides the students with a photo-
graph to scale, but a more common use would be for scaling screen grabs of inter-
face elements such as dialog boxes or panels.

Supply the students with such an image and have them use the 9-slice scaling tool 
to alter the image size in a single direction.

Adjusting the tonal range
Photoshop may be the king of bitmap editors, but Fireworks has a wide range of 
features to help you correct bitmap images, including some non-destructive ones.

Point out that several corrective tools are available in the Live Filters > Adjust 
color menu, including Auto Levels, Levels, Curves, Brightness/Contrast, and Hue/
Saturation.

All Live Filters remain editable during the current session and remain so if the fi le 
is saved as a Fireworks PNG fi le.

Point out that Live Filters must be applied to an entire selected object. To apply 
corrective fi lters to a specifi c area of a bitmap, a bitmap selection must fi rst be 
made and then the fi lter is applied from the main Filters menu. Unlike Live Filters, 
these adjustments permanently alter the selected area.

Live Filters are also used when applying the Unsharp mask in a later exercise in
this lesson.

Using the Align panel
Smart Guides are a new alignment feature in Fireworks, but the old standby, the 
Align panel, has also been updated in Fireworks CS4.

Point out that you can align images to each other whether they are bitmap, vector, 
text or groups, or to the canvas.

Adjusting brightness with the Dodge and Burn tools
Th is exercise and the Rubber Stamp exercise both rely on permanently altering pix-
els. Demonstrate what this means in a workfl ow to preserve original image infor-
mation, from working on a duplicate bitmap image to opening a fi le as untitled 
document.
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Repairing areas with the Rubber Stamp tool
Point out that for accurate retouching, it’s a good idea to zoom into the area to be 
fi xed. In many cases, soft-edged brushes make for a more realistic eff ect because 
the edge of the Rubber stamp blends better with the surrounding area.

Using the Rubber Stamp requires that you sample an area fi rst. Point out that you 
can resample as often as you feel is necessary to produce a satisfactory result.

Retouching on a separate bitmap object
Th is is the prep work for the instant facelift exercise. It discusses why retouching on 
a separate bitmap object is good professional practice and shows the steps needed 
to add the new bitmap object.

In this scenario, an empty bitmap object is used, rather than duplicating the origi-
nal bitmap object, but either workfl ow is useful and preserves the original bitmap.

Another advantage of retouching in a separate bitmap object is that the opacity 
of the entire object can be reduced for a more subtle eff ect, or the retouching can 
even be deleted or hidden if it is no longer desired.

Instant facelift
Th is exercise combines the use of a separate bitmap layer, bitmap selection tools, 
and the Rubber stamp to correct overexposed skin tones while retaining the origi-
nal bitmap information.

Because the students will be applying the retouching to a separate bitmap object, 
sampling options in the Property inspector will need to be altered.

Point out that the opacity of the Rubber Stamp can be altered as well, which can 
create a more subtle result.

Questions
Th e following questions are not in the student’s Classroom in a Book.

1. Why would you use the Unsharp Mask Live Filter?

2. What tool can be used to brighten a specifi c area in a photo?

3. What tool can be used to darken a specifi c area in a photo?

4. Why would you group objects together and how do you do it?
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Answers
1. Images that have been resized smaller tends to also become softer in appearance 

due to the reduction in pixels, but you can gain back some of the original 
crispness of the photo by applying a fi lter called Unsharp Mask. Unsharp Mask 
can be applied as either a permanent fi lter or as a Live Filter. For the greatest 
fl exibility, Live Filters are a better option.

2. Th e Dodge tool can be used on photos or other bitmap objects to lighten an 
area by painting over it. You can adjust the brush (tool) size, softness, shape, 
exposure (degree of eff ect), and the tonal range (shadows, midtones, highlights) 
you want to alter.

3. Th e Burn tool does the opposite of the Dodge tool, darkening areas where the 
tool is applied. Th e same tool attributes as the Dodge tool can be adjusted in the 
Property inspector.

4. Grouping related objects (a navigation bar, for example) makes it easier to 
reposition all the related objects in a single action. Grouping also simplifi es the 
Layers panel, because grouped objects only show as a single object. You can 
group two or more objects by Shift-clicking on the objects and then choosing 
Modify > Group or pressing Ctrl+G (Windows) or Command+G (Mac).

Lesson 3: Working with Selections
Th is lesson introduces learners to working with bitmap selections. In order to limit 
bitmap eff ects to a specifi c area of an image, a bitmap selection must fi rst be made.

Point out to students that anything outside the selection will remain unaltered.

Fireworks works equally well with vectors and bitmaps, and becoming aware of this 
fl exibility is important to realizing the full potential of Fireworks.

Th e basics of opening, importing, cropping, and retouching images will be covered 
in this lesson.

Goals for this lesson
With the solid set of Bitmap tools in Fireworks, there will be many situations where 
the user can work entirely within Fireworks without having to switch to other 
applications. Th e overall objective of this lesson is to familiarize users with these 
tools and give them insight into how images can be retouched using bitmap tools 
such as Dodge and burn or the Rubber Stamps, or in a non-destructive manner 
using Live Filters.

After completing the lesson, they should be able to do the following:

• Make specifi c areas of an image active using selection tools
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• Create a selection with the Magic Wand

• Adjust the edge of a bitmap selection

• Apply corrective fi lters to a selection

• Make complex selections using the Lasso tool and Magic Wand tool

• Modify a bitmap selection

• Save a bitmap selection for future use

• Deselect a selection

• Convert a bitmap selection to a path

About selecting objects and selection tools
Th is section gives an overview of the bitmap selection tools and discusses their 
various features. Point out to students that when making selections, you can switch 
back and forth between the tools, using whatever tool is most suitable for the work. 

Combined with the sidebar called Bitmap selection tool primer, learners will 
quickly get a sense of the options available.

Selecting and modifying with the Magic Wand tool
Selecting an area is one of the fi rst steps to altering part of a bitmap. Th is exercise 
walks the learner through a tried and true workfl ow for bitmap editing, including 
the creation of a duplicate bitmap object.

Using the Magic Wand with keyboard modifi ers
While this exercise uses the Magic Wand, point out that all the bitmap selection 
tools allow you to modify (add to or subtract from) the current selection using the 
same keyboard modifi ers.

Saving bitmap selections
Point out that when creating complex selections, it can be very helpful to save 
those selections for later use. Multiple selections can be saved with any fi le, so long 
as it is saved as a Fireworks PNG fi le.

Selecting with the Lasso tool
Th is exercise demonstrates how selection tools can be used interchangeably. Th ey 
start by using the Magic Wand to select a large area of similar color, then zoom in 
and use the Lasso tool and modifi er keys to further refi ne the selection. 
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Converting a selection to a path
Because Fireworks can edit both vectors and bitmaps, it makes sense that bitmap 
selections can also be converted to vector paths. Point out that paths can be easier 
to edit than bitmap selections, thanks to the individual control points of a vector. 
Also, the students aren’t as likely to delete an entire path by accident, something 
that is easily done with a bitmap selection by forgetting to use the Shift and Alt 
(Windows) or Option (Mac) modifi er keys when adjusting a bitmap selection.

Questions
Th e following questions are not in the student’s Classroom in a Book.

1. How do you create a soft-edged selection?

2. What does Live Marquee do?

3. How do you save a bitmap selection?

4. How do you convert a bitmap selection to an editable path?

5. Why would you use the Select Inverse command?

Answers
1. You can create soft-edge selection by applying a feather to the selection. 

Feathering can be applied in three diff erent ways:

•  Select the feathering option in the Property inspector before the selection 
has been made.

•  Apply the feather afterwards using the Property Inspector and Live Marquee.

• Choose Select > Feather from the menu.

2. Live Marquee gives you immediate control over the edge of your bitmap 
selection after it has been drawn. You can choose Hard for an aliased hard-
edged selection; Anti-aliased for a softer, slightly blended selection edge; or 
Feathered for a very soft blend.

3. Once a bitmap selection has been made, choose Select > Save Bitmap Selection. 
You can name the selection in the dialog box that appears.

4. You create a path from a bitmap selection by choosing Select > Convert 
Marquee to Path. Th e bitmap selection is deleted when you do this, but 
Fireworks also has a command to convert paths to bitmap selections, so the 
process is easy to reverse.

5. Selecting the unwanted part of the image is sometimes easier. Select Inverse is 
used to toggle the active selection between the original selection and the non-
selected areas. 
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Let’s say you have a photo of a city scene with a clear sky in the background. 
You want to do some levels or fi lter adjustments to the city area. It will be easier 
(and faster) to use the Magic Wand tool to select the evenly colored sky. Th en 
you can go to Select > Select Inverse to reverse the selected areas, making the 
city scene the active selection.

Lesson 4: Working with Vector Objects
Vectors are a key design element within Fireworks and will be needed in almost any 
design a user creates. Th is lesson shows the learner how to create and edit vector 
graphics and how fl exible this graphic format is as a design tool.

Learners will also use the 9-slice scaling tool again, only this time on vector objects. 
Th is is a good opportunity for them to practice with this tool and learn about more 
about the diff erences between vectors and bitmaps.

If the learners have no previous vector art experience, the Pen tool can prove to be 
a somewhat intimidating tool. Extra practice creating their own custom shapes, as 
well as adding additional control points to existing paths, are recommended.

Looking forward, in Lesson 6 (Masking) you will be working with both bitmap 
selections and vector shapes to create masks for a variety of objects.

While only mentioned briefl y in the lesson, we recommend you take time to 
explore the Path panel. Th is would be more of an intermediate exercise for you to 
create, but the Path panel is a very powerful tool.

Goals for this lesson
After completing the lesson, the students should be able to do the following:

• Draw simple vector shapes

• Demonstrate the diff erences between vector and bitmap images

• Use the 9-Slice scaling tool to scale vector shapes

• Demonstrate how to use Auto Shapes

• Create paths with the Pen tool

• Edit paths with the Pen and Subselection tools

• Create a custom shape

• Customize the fi ll and stroke of a vector shape
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Basic vector drawing techniques
In Lesson 1, the learner created their fi rst vector shape – an ellipse. In this exercise, 
they will delete the ellipse and add a rectangle. Point out how easy it is to round 
off  the corners of the rectangle, either while they are drawing it or later using the 
Property inspector. 

About bitmap images and vector graphics
While introduced a bit later in the lesson, you might want to spend some time up 
front comparing vectors and bitmaps on screen, showing the diff erences between 
the two main graphic formats.

Distortion-free scaling with the 9-Slice scaling tool
Point out that the 9-slice scaling tool is most useful on vectors that are mostly rect-
angular in shape. 9-slice scaling an ellipse, for example won’t produce a desirable 
result because the tool needs straight paths in order for the scaling to work. 

Adding text to your design
Text is covered in much more detail in its own lesson (Lesson 7), but now is your 
chance to introduce the Text tool and demonstrate how to change font families, 
styles, and color.

Working with Auto shapes
We only work with one auto shape in this exercise, but there are many to choose 
from. Point out that other shapes can be found in the Shapes panel and take time 
to experiment with them. You might want to consider giving the students an extra 
credit project to create a logo using Auto shapes.

You may also want to expose them to the Auto Shapes panel, where they can edit 
the properties of an Auto Shape without having to drag the yellow control diamonds.

Understanding paths and the Pen tool
Be prepared to spend extra time in this area if your students do not have any vector 
drawing experience. Profi ciency with the Pen tool means they are not locked in to 
using the standard shapes supplied by Fireworks; they can create their own. Th e 
Pen tool also is very useful for creating custom mask shapes. Make sure they also 
take time with the Subselection tool to practice editing the points of a new or exist-
ing vector shape.
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Other vector tools (sidebar)
No specifi c exercise was created for the other vector tools, but this can be another 
opportunity for you to help your students gain confi dence and get even more cre-
ative with vectors. Each tool’s functionality is outlined in the sidebar.

Editing paths
Th e real power in vectors is in knowing how to edit them to get the results you 
want. Your main tool for editing a path is the Subselection tool. Point out that you 
can edit individual control points by selecting them with this tool, or you can hold 
down the Shift key to select multiple points and move them at the same time. Give 
your students time to practice altering a curve by dragging the Bezier curve control 
arms

Creating a custom shape
Many things covered in Lesson 4 lead up to this fi nal exercise. We’ve intentionally 
kept the shape simple (no curves) but feel free to encourage your students to push 
their newfound skills.

For those having diffi  culty, we’ve hidden and locked a copy of the custom shape, 
which they can use as a tracing guide, by revealing the shape in the Layers panel.

Questions
Th e following questions are not in the student’s Classroom in a Book.

1. How do you create a curved path?

2. What tool is used to edit vector control points?

3. How do you fi ll a vector shape with a pattern?

4. How do you add additional control points to an existing path? 

5. How do you remove extra control points from a path?

6. Other than the Tools panel, where else can you fi nd more vector shapes to use?

Answers
1. You create a curved path by fi rst selecting the Pen tool. Th en click and drag an 

existing control point in a vector shape to pull out the bezier curve control arms. 
After a curve has been created, you can further edit it by dragging the control 
arms or the control point with the Subselection tool.

2. Th e Subselection tool can be used to move existing control points of a path, or 
alter the curve of a curved path segment.



18 INSTRUCTOR NOTES

3. To fi ll a vector shape with a pattern, select the shape with the Pointer tool, and 
then choose Pattern from the Fill Category and select pattern.

4. To add more control points to a path, select the Pen tool, and then click on the 
path where you want to add a new control point. 

5. You can remove a path by hovering the Pen tool over an existing control point. 
When you see the (-) sign beside the Pen tool cursor, click to remove the point.

6. You can fi nd additional Auto Shapes in the Shapes panel. If you do not see the 
Shapes panel, select Window > Shapes.

Lesson 5: The Layers Panel 
Layers are probably the most important workfl ow and design tool you have in 
Fireworks. Simply put, they add structure to your document. 

Th roughout this lesson, emphasize the importance of naming layers, sublayers and 
objects as the students work in Fireworks. It’s tempting to just zoom ahead with 
a design, but if the habit of naming elements can be made early, they—and their 
associates—will save time down the road, because it will be easier to fi nd what they 
are looking for in a complex document.

Goals for this lesson
In this lesson, they will learn how to do the following:

• Create new layers

• Create sublayers

• Change the stacking order of layers

• Rename layers

• Protect layers and objects

• Access Layer options

Using the Layers panel
Unlike Photoshop, Fireworks is an object-based application. Th is means that each 
layer can contain one or more independent objects, as well as sublayers. Objects 
can be text, bitmaps, vectors, groups or symbols.

Point out that Layer hierarchy (layers and sublayers) can help from an organiza-
tional point of view, but the primary existence of sublayers (at this time, anyway) is 
to maintain integration with Photoshop and its layer groups capabilities.

A layer containing one or more sublayers becomes a Layer group when the 
design is saved in Fireworks or as a Photoshop fi le. Likewise, if a student opens a 
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Photoshop fi le that contains layer groups, Fireworks will recognize and maintain 
this structure using layers and sublayers.

Rearranging objects within a layer
Point out how easy it is to drag and drop a selected object from one layer into another.

Moving objects from one layer to another
Point out how easy it is to drag and drop a selected object from one layer into 
another, using the radio button on the right side of each layer name. 

When this button is dragged from one layer to another, only the selected objects in 
the original layer are moved.

Creating sublayers
Sublayers are helpful from a structural point of view and for integration with 
Photoshop’s layer group feature, but they are also limited in many ways. Th e limits 
of sublayers are discussed in a sidebar in Lesson 11, so you might want to read 
ahead a little. Forewarned is forearmed. 

While not part of this lesson, you may want to build a simple design using both layers 
and sublayers ahead of time, and show students briefl y how the layer structure appears 
if the design was saved as a Photoshop fi le, and then opened in Photoshop.

Questions
Th e following questions are not in the student’s Classroom in a Book.

1. What is the importance of sublayers?

2. How do you protect a layer or an object from accidental editing?

3. Why is it important to name your layers and objects?

4. How do you create a sublayer?

5. How do you rename layers, sublayers or objects?

Answers
1. Sublayers help you add structure to your document, allowing you to group 

related objects within an existing layer. If a Photoshop design is opened within 
Fireworks, and it contains layer groups, Fireworks maintains this relationship 
using layers and sublayers.

2. You can protect all the objects in a layer by locking the layer (empty square next 
to Layer name). You can also protect individual objects in a layer (rather than 
all the objects in the layer) by locking them independently. Locking a layer will 
protect all objects, regardless of the lock status of individual objects.
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3. Naming Layers can help other members of your design team, because things are 
easier to locate when they are named. It can help you as well, by aiding you to 
logically structure the Layers and when you need to locate a specifi c object on a 
specifi c layer.

4. You create a sublayer by fi rst selecting the layer you want to contain the 
sublayer. Th en choose New Sublayer from the bottom of the Layers panel or 
by right-clicking (Windows) or Control-clicking (Mac) the main layer and 
choosing New Sublayer from the context menu.

5. You can rename any layer, sublayer or object by double-clicking on the default 
name (Layer 1, for example).

Lesson 6: Masking
Th is is where your students really start to work! Lessons 1 – 6 cover the basics of 
working in Fireworks, but in this lesson they will be building a banner ad practi-
cally from scratch and making use of one of Fireworks’ star features: masking. 
Depending on your group’s skill/comfort level, you might consider breaking this up 
into two classes.

Students will be importing graphics, working with both vector and bitmap masks, 
adding some text and learning nifty tricks such as how to paste the attributes of 
one object onto another object.

Th ere’s even an extra credit assignment. Students get some practice with the 
Polygon lasso tool to create a selection, which then gets converted to a path. If you 
feel they need more practice with the Pen tool, this exercise can be easily adapted 
to working with the Pen tool instead.

Goals for this lesson
In this lesson, they will learn how to do the following:

• Create a bitmap mask from a selection

• Edit a bitmap mask using the Brush tool

• Create a vector mask from a custom vector shape

• Edit the vector mask and change its properties using the Property Inspector

• Use the Auto Vector Mask command

Bitmap masks and vector masks – what’s the diff erence?
We’ve spent a fair amount of time up front discussing the two main types of masks you 
can create in Fireworks. You might want to have students try out some simple mask-
ing exercises of your own creation before jumping into the main lesson in the book.
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While not discussed in this lesson, you can also mask one bitmap object with 
another, which can create interesting texture and eff ects. Read through the Help 
fi les to learn more about masking one bitmap with another.

Editing gradient direction and angle
Gradient fi lls are a very popular web design element, as well as a visual design ele-
ment. Extra practice with manipulating gradients is a good idea and using gradients 
comes up in several lessons.

Importing assets
Point out this commonly used technique to save the user a great deal of time. No 
need to copy and paste, or drag and drop images into a design when you use the 
Import command.

Using the Auto Vector mask for quick fades
If your users have worked in earlier versions of Fireworks, point out that the Auto 
Vector Mask command was previously named the Fade Image Command. It can be 
applied to both bitmaps and other vector objects.

Importing Photoshop images
Th e Photoshop fi les used in this lesson are simple, fl at bitmaps, but this does give 
you the opportunity to go over the Photoshop Import dialog box. At the end of 
the lesson, you may want to show them how to customize the Photoshop import 
options using the Preferences panel.

Creating a vector mask
Th e vector mask created in this exercise is a simple one, but point out that custom 
vector shapes can also be used as masks.

Converting a bitmap selection to a mask
Th e other main type of mask you can create is a bitmap mask. Th ese are similar 
to Layer masks in Photoshop. Point out you can use any of the bitmap selection 
tools—or combinations of those tools—to create the selection. It can be easier 
at times to create a mask using selections, especially if you have an image with a 
strongly contrasting background. Th e Magic wand can quickly select the back-
ground, and then the selection can be inverted and the mask applied.
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Editing a bitmap mask
For those not comfortable with the vector tools (we recommend practice, of 
course), editing a bitmap mask may be less intimidating because it uses the Brush 
tool. Paint with white to reveal the image or paint with black to hide the image.

Extra credit: Creating a silhouette vector shape from a bit-
map image
Th e main lesson gives the student a silhouette image to use, but for those who want 
to know how it was done, this extra credit exercise should help. Th is exercise has 
the students use the polygon lasso to create a bitmap selection, which is then con-
verted to an editable path, fi lled with black.

Final touches
Th is section covers a variety to exercises to wrap up the design. A good deal of work 
is done with text, as can be seen from the list below. Point out that on completion, 
students will have applied many of the core skills they have learned in previous les-
sons and have built the entire design from the ground up.

• Adding text

• Adding the cast names

• Styling the text

• Creating and applying a custom style

• Styling the fi rst names 

• Tweaking the background

• Image positioning

Questions
Th e following questions are not in the student’s Classroom in a Book.

1. How do you edit a bitmap mask?

2. How do you apply a gradient to a vector shape?

3. How do you edit the colors of a gradient?

4. How do you reposition an object within a mask?

5. How do you convert a bitmap selection to a path?
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Answers
1. You edit a bitmap mask using the Brush tool. All the attributes of the Brush tool 

are available, such as size, stroke category, edge softness, and opacity. Choose 
black to add to the mask (hiding the object) or white to remove the mask 
(revealing the object). 

2. Select the vector shape and then choose your gradient type from the Fill 
category.

3. Select the vector that has the gradient fi ll. Th en click on the color swatch in the 
Property inspector. Th is launches the gradient editor. You can pick from several 
color presets, or click on the existing color swatches to open the color picker. 
You can add additional colors to the gradient by clicking underneath the color 
ramp.

4. Make sure the object being masked is active. Using the Pointer tool, drag the 
blue control handle on the canvas to reposition the image within the mask.

5. Once the selection has been created, choose Select > Convert Marquee to Path. 
Th e bitmap selection is discarded and replaced with a vector shape.

Lesson 7: Working with Text
Th is lesson builds on the basic text skills students have been gaining up until now 
and covers more advanced typography features, as well as some brand-new features 
such as wrapping text within a path.

Adobe Fireworks CS4 marks the introduction of the Adobe Type Engine. Now 
Photoshop, Illustrator and Fireworks all use the same text renderer. Th ere are 
issues, however, with this new integration, especially when opening fi les created in 
earlier versions of Fireworks. At this writing, a patch to fi x the text problems has 
been promised by Adobe, so please check with your IT department to keep an eye 
out for it and to install it as soon as possible. Fireworks engineer Sarthak Singhal’s 
blog http://blogs.adobe.com/sarthak/will keep you updated on the progress of the 
patch and give you many other helpful tips on working with Fireworks.

Goals for this lesson
In this lesson, they will learn how to do the following:

• Create both fi xed-width and auto-sizing text blocks

• Edit the text properties

• Use Commands to alter text

• Use the transform tools to scale, rotate and distort text
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• Use text as a mask

• Attach text to a path

• Flow text within a vector shape (attach in path)

About text
Th is section, along with Creating a fi xed width text box and Editing text give a basic 
but thorough introduction to adding text to a Fireworks document. Point out to 
students how you can easily select a text block with the Pointer tool to reposition 
it, or jump into text edit mode just by double-clicking on the text itself with the 
Pointer tool.

Flowing text within a vector shape
New to Fireworks CS4 is the ability to attach text in a path. Text can be fl owed into 
any closed vector path—with the exception of composite paths. Point out that this 
can be a useful visual design technique, and can also be used to mimic how text 
would wrap around a fl oated graphic on a web page.

Typography terms (sidebar)
Fireworks has some pretty advanced text attributes to help designers make the 
most of text in a design. Th e terms in this sidebar all relate to the attributes avail-
able within the Property inspector when the text tool is active.

Anti-aliasing text
Th e introduction of the Adobe type engine has also had an eff ect on the Anti-
aliasing features of Fireworks. Demonstrate to students how the diff erent anti-alias-
ing settings can aff ect the display of text on screen and how, for example, small font 
sizes are more readable when anti-aliasing is turned off .

Skewing text
Text can be scaled, distorted and even skewed while still remaining editable. 

While not covered in this lesson, you can also point out that text can be converted 
to regular vector paths if the user needs to do special work on the text, or if the fi le 
is being passed to someone who does not own the fonts used in the design.

Using text as a mask
Point out that text can mask another vector or even a bitmap image and, as always, 
the text remains editable. You can combine various techniques such as attaching 
text to a path and then using it as a mask over a photograph, or adding Live Filters 
to masked text.
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Also point out that at times it may be easier to use the Text menu to make altera-
tions to text. Th is can be the case when you have combined multiple eff ects such as 
masking and attaching text to a path.

Questions
Th e following questions are not in the student’s Classroom in a Book.

1. What is one method to apply text as a mask?

2. How do you skew or distort text without converting it to paths?

3. What is the best anti-aliasing setting for small type (10 point or below) and why?

4. Where do you fi nd commands such as Lorem Ipsum or Case Uppercase?

Answers
1. Select the text block and cut it. Select the object you want to mask and choose 

Edit > Paste as Mask.

2. Select the text block and then choose the Skew or Distort tool from the Tools 
panel. Th ese tools are grouped with the Scale tool. Drag the control handles 
which appear around the text block to transform the text block.

3. For text 10 points or smaller, the No Anti-alias setting should be used. Th is 
makes small text more readable. Anti-alias blurs or blends the text edge with the 
background color, and this can make the text hard to read with small font sizes.

4. A variety of text commands can be found in the Commands > Text menu.

Lesson 8: Optimizing for the Web
In Lessons 2, 3 and 4, students learned the basics for working with graphics in 
Fireworks. In this lesson they will apply those skills to creating assets for Web 
pages and Web page creation itself. 

Goals for this lesson
In this lesson, they will learn how to do the following:

• Export a single image to a web-ready format

• Determine the optimal web format for a sliced graphic

• Use the Optimize panel and Preview views to optimize images for web use

• Use the slice tool to slice up graphics in a web page mockup

• Use the slice tool to create a rollover eff ect

• Use the Hotspot tool to create interactivity
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• Preview a web page design in a Web browser

• Export a interactive mockup of a website

• Export a single page as a standards-based CSS and HTML web page

Image optimization
Th is is a very important topic when it comes to the web. It can be easy to forget 
that not everyone has a high-speed Internet connection, but as professionals, web 
designers should take into account that people can be viewing a website with a 
wide variety of technology and at diff erent bandwidths. Th e fi rst few sections of 
this lesson cover image optimization in detail, starting with why it’s important, 
then leading into the diff erent web graphic formats.

Why optimize images?
Th is section and the one following (Web graphic formats) explain why optimizing 
graphics is so important for websites and discusses in detail the diff erent formats 
available for use on the web. 

We recommend that you again reinforce the diff erence between Fireworks PNG 
fi les and standard, fl at PNG fi les. It’s very important that students understand that 
Fireworks PNG fi les should not be part of a fi nal web page design. A discussion of the 
diff erences between saving fi les in Fireworks and exporting them is also a good idea.

About the Optimize panel
Point out that like many aspects of Fireworks, the Optimize panel works in con-
junction with several other elements of the interface: the preview buttons, the 
Property inspector and slices. 

While not covered in the lesson, take the time to demonstrate other methods of 
optimizing and exporting fi les such as the Image Preview command and the Export 
Wizard. If the students are new to Web design and image optimization, the Export 
Wizard can be a helpful tool in the beginning.

Optimizing a single fi le
Several sections are dedicated to this exercise—working with previews, choosing 
optimization settings and exporting the fi le, building a foundation and explaining a 
workfl ow—which students can follow when optimizing single images or a series of 
image slices.

Fireworks web tools and slicing 
Th is is the fi rst real introduction to the web objects in Fireworks. Begin by explain-
ing what slices and hotspots are, and how they are diff erent from each other. 
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Getting comfortable with slicing a design is an integral part of using Fireworks as 
a Web design tool. We recommend you keep things simple and only work with 
rectangular slices. Polygonal slices add an extra level of complexity to a web page 
because a single polygonal slice becomes several smaller rectangular images, linked 
together with hotspots in the HTML code. Not a lot of fun for the novice, if they 
have to edit code.

Optimizing a sliced image
Th is is a short section, essentially telling the students what to do, but we recom-
mend you walk your students in sections through the same previewing process 
as outlined earlier, beginning with Optimizing a single fi le. We can’t emphasize 
enough the importance of becoming profi cient with image optimization or its 
importance to a website.

Optimizing illustrations
Th is section tackles the process of choosing the right fi le format for non-photo-
graphic images. You may be tempted to fall back on the GIF format for this type of 
image, but in many cases (not all) PNG 8 actually produces a smaller fi le.

Creating hotspots
Hotspots are the other web object available in Fireworks. Unlike slices, hotspots are 
only suitable for interactivity; they cannot be used to cut up a design into smaller 
images. But they are powerful nonetheless. Take some time to discuss the strengths 
of hot spots. You may want to read ahead to lessons 10, 11 and 13, where both Web 
objects get a real workout, so you can present some examples of advanced interac-
tivity, such as mocking up an Ajax data table or pop-up window.

Adding interactivity 
Th is exercise introduces students to the concept of rollover images and how to 
create them; it’s a bit of foreshadowing of what’s to come in Lesson 11. While the 
exercise only walks them through the process of creating a single rollover, feel free 
to expand on this and have them create rollover eff ects for the other two sub head-
ing images in the page design. Th is will also give them a chance to experiment more 
with Live Filters. 

Caution students on using fi lters which increase the dimensions of an image; this 
could become problematic in the fi nal web layout due to size diff erences. If they 
want to add an outer glow or drop shadow in the second state, this is a good time 
to explain that the slice needs to be sized based on the eff ect used on the rollover 
image, not the original image in the fi rst state.
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Exporting HTML and images
Fireworks has two main workfl ows for converting designs into web pages: Export 
as HTML and Images, or Export CSS and Images. Th e fi rst of these two export 
workfl ows has been around since Fireworks began and produces a rigid table-based 
layout, where everything in the web page (including text) is turned into graphics. 
While it’s not a good practice to use this option for a real website, it defi nitely has 
its advantages when creating interactive prototypes because it is quick and easy.

It’s important to stress that students should never use the HTML and Images 
export for a fi nal website, and there are many reasons for this: accessibility, search 
engine indexing, text-based browsers and site maintenance, to name a few.

Exporting states
Th e export process does have a few kinks in the workfl ow; a design with multiple 
states (one with rollover eff ects for example) is one of them. As soon as you add 
extra states to a design, Fireworks will export images for the entire design on all 
states, even when there is no image information. Th is section describes a work-
around that will avoid the creation of multiple unnecessary image fi les.

Exporting CSS and images
Th is is the fi rst time true CSS export has been done natively within Fireworks. Th e 
Export engine is based on John Wylie’s Smart CSS export, which was available as a 
plug-in for Fireworks CS3.

Th e goal behind CSS and Images export is to produce a web page right from 
Fireworks that meets standards compliancy for HTML and CSS. Th e resulting 
HTML and CSS documents can be edited within Dreamweaver or any other web 
editing software.

At this time, you can only export 1 page of your design at a time. Th e reason behind
this is that most web pages in a site have a similar layout, so you would fi rst export 
the one page that represents your main site. Th en you design, edit and twea within 
Dreamweaver, and generate new pages within the HTML editor rather than Fireworks.

Point out that states and behaviors are ignored during the export. Th ese features 
would have to be added back in when you are editing the web page itself.

It’s a good idea to read the following articles ahead of time and make them avail-
able to your students.

http://www.adobe.com/devnet/fi reworks/articles/export_css_images.html

http://www.adobe.com/devnet/fi reworks/articles/standards_compliant_design.html
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Questions
Th e following questions are not in the student’s Classroom in a Book.

1. Why are images sliced? 

2. What does the Optimize panel do and how do you access it?

3. What options do you have for previewing your optimize settings within 
Fireworks?

4. What is the best format for optimizing photographs?

5. What are the diff erences between PNG 8 and GIF?

Answers
1. Generally, images are sliced in order to break up a larger design into smaller, 

more manageable graphics. Traditionally, these graphics were added to a table-
based layout to “rebuild” the design in an HTML page. Th e common practice 
now is to slice a design so that only the necessary graphics are exported and 
those images are used as either foreground or background images within a CSS-
based layout.

2. Th e Optimize panel gives you complete control over the export format and for 
a selected slice, or over global formatting options for any areas in the design 
that are not sliced. To access the Optimize panel, select Window > Optimize or 
press the F6 key.

3. You have three preview options built into the Fireworks interface: Preview 
(single view), 2-Up (two customizable views), and 4-Up (four customizable 
views for comparing optimization settings).

4. Th e best export format for a photograph is JPEG, because it supports photo-
realistic (24-bit) color. You can balance the amount of quality loss against the 
fi le size when using JPEG as the export format by dragging the quality slider.

5. You can create animated graphics with GIF and set one color (usually the 
background color) as transparent. PNG-8 does not off er animation, but it does 
off er a wider range of transparency options and often compresses simple images 
better than GIF.
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Lesson 9: Using Symbols
Symbols are one of the great timesaving features in Fireworks. Th ey’ve been around 
since the fi rst release of the application. Point out that symbols can contain mul-
tiple objects within a single asset and still give you quick access to editing those 
objects. Symbols can contain text, vectors, and bitmaps, each with their own Live 
Filter attributes.

As well as being an option for reusing common graphical elements in a design—like 
a logo, or a button—symbols can also be exported and shared with others. 

Goals for this lesson
In this lesson, they will learn how to do the following:

• Create a graphic symbol

• Create an animation symbol

• Create a button symbol

• Edit a graphic symbol

• Edit an animation symbol

• Edit a button symbol

• Save a symbol to the Common Library

What are symbols?
 It’s important for students to know that a symbol is really made up of two parts: 
the symbol itself and the instance on the canvas. If you want to make global 
changes to all the instances in a design (the color of a button, for example), you 
need to do this by editing the symbol itself. 

Point out that they also have some editing control over individual instances: 
size, opacity, blending modes and Live Filters can be added directly to individual 
instances without aff ecting the original symbol.

Th ere are three main types of symbols, plus an enhanced graphic symbol called a 
Component symbol. Component symbols have JavaScript functionality built into 
them and are usually edited with the Symbol Properties panel. As this is a fairly 
advanced type of symbol, it is not covered in this book. Students will learn how to 
create each of the three main symbol types.

Lastly, you’re switching visual gears in this lesson, taking a break from the Double 
Identity assets and working with something completely unrelated. 
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Graphic symbols
Th e lesson starts off  with converting an existing graphic to a graphic symbol. Th is is 
the simplest of all the symbols to work with, but can be very useful. As an example, 
point out the Common Library to your students. Th ere are several folders (web and 
applications folder is a favorite of ours) full of graphic symbols, and while your stu-
dents may be starting off  simple, it’s easy to see that graphic symbols can become 
quite robust.

We recommend pointing out the shortcut key for creating symbols, which is F8.

The Common Library
Point out that the Common Library lets users share symbols across multiple docu-
ments in Fireworks. You can add a symbol to the Common Library at the time it is 
created, but this also removes the artwork from the canvas. A symbol can be added 
to the Common Library at any time, by selecting it in the Document Library and 
choosing Save to Common Library from the panel options.

Editing symbols 
New in Fireworks CS4 is the ability to edit symbols in-place, as you would in Adobe 
Flash. Double-clicking on an instance will fade all other elements on the can-
vas, making the symbol the only editable element on screen. A bread crumb trail 
appears at the top of the document window, making it easy to navigate back to the 
main design.

Demonstrate that you can also edit symbols in Isolation Mode by right-clicking 
(Windows) or Control-click (Mac) the instance and choosing Symbol > Edit 
Symbol. Th is editing mode hides all other objects on the canvas and may be helpful 
if you have a complicated design.

Button symbols
Button symbols take a little more planning than a simple graphic symbol. Th is can 
be a good place to talk a bit about site planning and best practices, because button 
symbols are most useful if they have text labels. It’s important to know what the 
site architecture will be so that you can plan your button dimensions based on the 
longest string of text.

Th e button symbol is designed to export up to four diff erent graphics for each 
button (up, over, down, over while down). Unlike graphic or animation symbols, 
Fireworks automatically slices button symbols, because it’s assumed the user will 
want to create a rollover eff ect.
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While Fireworks can’t directly create CSS-based button rollover eff ects, you may 
want to make your students aware of the growing popularity of this technique, and 
demonstrate how Fireworks can fi t into this workfl ow by creating the background 
image for the CSS button.

Editing a button symbol
Button symbols have special properties that can be accessed after double-clicking 
on the button instance. While in symbol editing mode, you can also add up to three 
more states and determine whether you want Fireworks to handle slicing automati-
cally or leave the slicing up to you. Point out that in order to add additional states, 
make sure nothing is selected on the canvas. Th en you will be able to add more 
button states from the Property inspector.

Testing the button symbol
Point out that the Preview options in Fireworks are not just for checking optimiza-
tion settings; you can test out state-based interactivity as well. Mousing over button 
symbols will show rollover eff ects and if there are any on-click events applied, they 
too will work, so long as it’s just a state change. Preview mode will not let you move 
to a diff erent page in the design.

Point out that if they want to test hyperlinks, they can choose File > Preview in 
Browser > Preview all pages in (default browser).

Point out that they will get a more realistic experience if they hide slices and 
hotspots while in preview.

Animation symbols
Th is exercise exposes the user to the States panel and the basic concept of 
frame-based animation, including onion-skinning and state delay. Point out that 
Fireworks animation capabilities are limited to what GIF animation can achieve. 
Complex animation should be done in a program such as Adobe Flash.

Also point out that because animations require several frames, it may be best to 
create the animation on a separate page, so that Fireworks does not export out 
multiple fi les for the rest of the design.

Altering animation settings
While not covered in the exercise, point out that several elements of the anima-
tion symbol can be added or altered in the Property inspector. You can change the 
number of states in the animation, alter opacity, size, and even rotation, after the 
symbol has been created.
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Adding pre-built symbols from the Common Library
To wrap up the design, students will create a mockup of a search fi eld. While there 
are HTML components in the Common Library for adding text fi elds, we went 
with just a simple white rectangle, and focused on dropping in a pre-built symbol 
for the magnifying glass. If you feel your students are up to the challenge and you 
want them to get a better handle on Component symbols, feel free to have them 
drag in a text fi eld from the HTML folder of the Common Library.

Questions
Th e following questions are not in the student’s Classroom in a Book.

1. What is a symbol?

2. How do you edit a graphic symbol?

3. How do you add a symbol to the Common Library?

4. What is Onion skinning?

5. How do you change the state-delay of an animation state?

Answers
1. Symbols are reusable graphic elements. Fireworks has three types of symbols: 

graphic, animation, and button. When you edit the original symbol object, the 
copied instances automatically change to refl ect the edited symbol (unless you 
break the link between the two).

Symbols are also helpful for creating buttons and animating objects across 
multiple states.

2. You edit a graphic symbol by double-clicking on the instance on the canvas, or 
by selecting the instance and then choosing Modify > Symbol > Edit Symbol 
(isolation mode) or Modify > Symbol > Edit in Place.

3. To add a symbol to the Common Library, select the symbol within the 
Document Library and choose Save to Common Library from the panel options.

4. Onion skinning is a technique for viewing the contents of states before and after 
the selected state. When you turn on onion skinning, objects in the preceding 
and subsequent states are dimmed so that you can distinguish them from 
objects in the current state. By default, Multi-State Editing is enabled so that you 
can select and edit dimmed objects in other states without leaving the current 
state. Use the Select Behind tool to select objects in states in sequential order.

You can adjust the number of states visible before and after the current one 
by clicking the Onion Skinning marker to set a range or by clicking the Onion 
Skinning button and selecting a display option. 
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5. You change the State delay of a frame by double-clicking the current delay value 
in the state delay column. You can change the delay of multiple frames by shift-
clicking to select a continuous range or control-clicking to select discontinuous 
states, then double-clicking on any of the delay values.

 Lesson 10: Prototyping Basics 
Fireworks is not just a graphic design tool for screen images. It has workfl ows 
to expedite a variety of professional production needs, from web page design to 
application interfaces, from rough concepts to fully detailed and interactive design 
comps. Th is is an important distinction for Fireworks.

It’s time to demonstrate and emphasize to students this feature set. In this lesson, 
emphasis is placed on working with the pages panel, shared graphic layers and 
shared interactive layers. Th e result at the end is an interactive PDF fi le that can be 
e-mailed to a client for review and feedback.

Goals for this lesson
In this lesson, they will learn how to do the following:

• Create a multi-page mockup

• Share layers to multiple pages

• Use the Hotspot tool to create interactivity between pages

• Preview a mockup design in a Web browser

• Export a secure, interactive PDF fi le

Pages panel
Point out that for prototyping, the Pages panel is extremely important, allowing 
you to keep an entire design concept within a single fi le. Th is makes linking to sepa-
rate pages very easy, which expedites the process of creating an interactive proto-
type. Th e pages panel is where you create new or duplicate pages, and designate a 
master page.

Master page
Take some time to go over the uses of the master page and its limitations. While 
not covered in the lesson, you can also demonstrate how to unlink a page from the 
master page. Each Fireworks fi le can only contain one master page.
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Pages
Th e generic term pages has been used throughout the book, but students may also 
hear the terms child pages when discussing pages that are linked to a master page. 
Pages linked to a master page take on the same dimensions and canvas, color, and 
optimization settings as the master page, as well as sharing (by default) the graphic 
elements from the master page.

Linking to a master page and sharing the master page layer on child pages are 
mutually exclusive options as well, although that may not be immediately obvious.

By default, if you have a master page, new pages will always have the master page 
layer added to them on creation.

However, pages do not have to share the master page layer—indeed, individual 
pages do not have to have anything in common with a master page. Th is can be 
quite useful when creating multiple design concepts in one fi le. Show how to 
remove the master page layer by choosing Remove Master Page layer from the 
Layers panel options menu. You can also use the options menu to add the master 
page layer back into a page.

Creating a multipage mockup
Up until this point in the lesson, students have been manipulating a nearly fi nal 
mockup. Now you will have them open a less complete version of the fi le and they 
will get lots of practice creating new pages as well as setting up a master page.

Sharing layers to pages
Th is workfl ow can save the user a lot of time when working on a design, and is not 
as limiting as a master page can be. Point out that sharing a layer to pages means 
you can be selective about which pages display the content from the shared layer. 
Th is is unlike a master page, where all the layers on a master page are either applied 
to the page or removed.

Th is can come in handy if the user wants to include contextual navigation on 
certain pages, but not on all the pages, in the design. It can also be helpful if you are 
working with diff erent page dimensions. You could have a footer layer that displays 
footer information at approximately 400 pixels from the top of the page for shorter 
pages, and another footer layer that displays the footer info at 900 pixels from the 
top. Short pages share one layer, long pages share the other.

Adding interactivity
A mockup without interactivity is just a storyboard, no matter how fi nished it 
appears. Point out that adding interactivity using a design tool can be a real time-
saver. No coding is required, so building the mockup and editing it based on client 
feedback is quick and easy.
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As you build your interactive objects (hotspots, in this lesson), point out that the 
links in the URL bar of the Property inspector are divided between session history 
(above the divider) and true links (below the divider). Only the links below the 
divider will generate functional links, even if there is a matching page name in the 
history section.

Point out also that PDFs only support rectangular web objects (slice or hotspot). In 
the case of this fi le, slices are not even used because individual slice optimization 
settings would be ignored on the export fi le.

Sharing interactive objects
Point out that sharing web layers to pages has the same advantages as sharing 
graphic layers, but there is an extra step the user has to perform in order to share 
a web layer. Th e creation of a web sublayer is required because the main web layer 
itself cannot be shared to other pages. Once a web layer is shared, changing the 
position, size or URL of a hotspot or slice will be refl ected on pages sharing the web 
sublayer.

Testing the links
Emphasize the importance of testing interactive elements. Rollovers and state 
changes can be previewed in the Preview mode, but page linking must be tested by 
previewing all the pages within a web browser.

Depending on the previous export settings, students may fi nd that their temporary 
web pages are graphically incomplete. If this occurs, the only workaround is to fi rst 
export the design as HTML and Images, making sure that Include areas without 
slices is selected and that Current page is deselected.

Th e next time they attempt a preview, things should work properly.

While not covered specifi cally in the lesson, it may be a good idea for students to 
set their base page optimization settings to JPEG – Better Quality before preview-
ing the work. Th is can make text a little fuzzy, but on average, it will give better 
graphical display.

Emulating state changes
As mentioned at the beginning, the end goal for this lesson is to produce an interac-
tive PDF. PDF fi les do not support states or rollover eff ects, so in order to mimic a 
change in the stare of the mockup, additional pages—rather than states—are used.

More hotspots!
Here you take advantage of the invisibility of hotspots to give the user some control 
over a few of the buttons on the phone.
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Creating a secure, interactive PDF
Th e steps for exporting an interactive PDF are outlined here. It would be good to 
have Acrobat Professional installed on the systems your students use, so they can 
enable commenting for Adobe Reader (this is something that Fireworks is not 
capable of doing) and test out the password protection for certain tasks.

Questions
Th e following questions are not in the student’s Classroom in a Book.

1. When you link a page to the master page, what is the result?

2. What elements might be best left out of a master page?

3. What security options are available when creating a secure PDF from 
Fireworks?

4. Why would you share a layer to other pages in a design?

5. What web objects can be used when creating interactivity for a PDF fi le?

Answers
1. Th e linked page takes on the canvas color and dimensions of the Master Page. 

Th e master page’s base optimization setting is also applied.

2. Because pages can change in dimension, it is best to only include objects on the 
master page that can remain in the same physical location on every page. Th is 
usually means that elements such as the footer are excluded from the master page.

3. You can set PDF security for fi le opening and for performing tasks. One 
password is used to open the fi le and another is used to enable the following 
tasks: printing, editing, copying and commenting. If no passwords are set, all 
tasks listed are available.

4. If you have content that needs to be on some but not all pages in your mockup, 
you can use Share Layer to Pages to specify to which pages the content should 
be shared. Updates to the shared layer can be made on any page sharing the 
layer and these updates will propagate across those pages.

5. Th e only web objects supported by PDF are rectangular slices or hotspots. 
Because PDFs do not support rollovers or state changes, it’s safe to use just the 
rectangular hotspot tool. Th e exception to this would be if the design is also 
intended to become a web page mockup, where slicing would be needed for 
optimization and visual interactivity.
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Lesson 11: Advanced Prototyping
Th is lesson uses new assets and builds upon the concepts learned so far regard-
ing slices, hotspots, states, and sharing layers to pages. In this chapter, they’ll take 
a closer look at creating eff ects such as rollovers and emulating pop-up windows 
(including two ways to create the pop-up window eff ect). 

While much can be done, it is important to remind students that Fireworks is an 
excellent graphics editor; however, it is not designed to be, nor should you expect it 
to be, an HTML web page editor or website creation tool.

Goals for this lesson
In this lesson, they will learn how to do the following:

• Create a multi-page website mockup

• Use the Slice tool to slice up graphics in a web page mockup

• Use the Slice tool to create a rollover eff ect

• Use the Hotspot tool to trigger a disjointed rollover (pop-up window) 

• Simulate a Spry data table (disjointed rollovers)

• Preview an interactive web page design in a web browser

• Export an interactive mockup of a website

Prototype orientation
A little repetition never hurt anyone, especially when they are learning something 
new. Th e opening exercises in Lesson 11 follow a similar format to Lesson 10: the 
student gets to explore a completed version of a website prototype. Th e lesson also 
shows them what their goals are and how the various elements should work when 
their version is completed.

Fleshing out the prototype
Having students build the entire prototype from scratch would be a pretty hefty 
endeavor for a single lesson, so the students will start with a working fi le that has 
many assets already added. In this second series of exercises, they will be creat-
ing the master page, adding additional pages, slicing the banner area, and adding 
hotspots for navigation.

Creating rollover eff ects
After the basic structure has been completed, they move on to creating rollover 
eff ects, using slices, states and shared layers. Emphasize the importance of naming 
slices and recommend options for some standard naming conventions.
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Students will have a chance to work with Live Filters again in these exercises, so 
point out that the various creative features of Fireworks can come into play at any-
time during prototype development; they aren’t limited to just the design phase.

While not mentioned in the exercise on creating a new state, take some time to 
remind them that they can rename states just as easily as they can name objects or 
layers. And if a great deal of interactivity is required, naming the states that repre-
sent that diff erent activity is a good idea. For example, instead of State 1 and State 2, 
these states could be named Up and Over to represent the diff erent rollover states 
that are being created.

Adding rollover behaviors
Th is will be their fi rst exposure to Fireworks behaviors, which are prebuilt 
JavaScript actions, so take some time to introduce the concept, explain what behav-
iors are and how to take advantage of them. Th e great thing about Behaviors is that 
no coding or knowledge of JavaScript is required.

Emulating pop-up windows
Th ese two exercises are excellent real-world examples of how a Fireworks proto-
type can aid the web designer and the client in visualizing the fi nal website.

With the advent of Ajax and Adobe’s Spry framework, dynamic interactivity on a 
web page is becoming more popular and easier to achieve than ever before. Take 
some time to discuss Ajax and display some examples of the technology. Th is 
will help students see the relevance/connection when they simulate this type of 
dynamic behavior within Fireworks.

Simulating a Spry data table
Th is exercise is more complex than the pop-up window exercise and not only 
requires the use of additional states and behaviors, but introduces learners to the 
Behaviors panel, where they can easily edit various attributes of preset behavior. For 
example, by default the Swap Image behavior is triggered when the user’s mouse 
rolls over the hot area. In this exercise, the goal is to swap the image only when the 
user clicks the hot area. Th is change is easily made using the Behaviors panel.

Take some time to explain the various JavaScript events and explore the Behaviors 
panel in more depth. Point out that with a bit of practice, their mockups can become 
quite interactive, mimicking (short of animation) features such as Spry accordion 
panels, tab panels, even photo galleries. Utilizing this type of interactivity defi nitely 
takes a mockup beyond the basic stage into a more robust and functional prototype. 
A client can truly get a “feel” for how the fi nal website will look and behave.
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Completing the prototype
Th is fi nal section walks them through two more exercises: importing a couple of 
prebuilt designs to complete the empty video and fashion pages created much 
earlier in the design, and exporting the prototype. While placed at the end of the 
lesson, there is no reason for you not to introduce this page imports earlier, if you 
desire. Point out that in this case, they aren’t just importing a single graphic, they 
are importing an entire layered PNG fi le. Once imported, have them expand the 
layers panel to see that the layers from the original PNG fi le have been maintained.

Exporting the prototype
Th e export workfl ow used for the prototype is HTML and Images. As mentioned in 
the book, this produces a series of very rigid, table-based HTML pages. While this 
end result is fi ne for prototyping purposes, be sure to stress that this export option is 
not recommended for a fi nal production website. Th ere are several reasons for this:

• Table-based layouts are no longer considered best practices.

• Multiple unnecessary images are exported in order to allow the table to display 
the design. Many images are exact copies of each other, created from the other 
pages in the design.

• All elements in the design are converted to graphics, including text.

• Editing the resulting HTML can be problematic; for example, deleting a graphic 
slice to replace it with true HTML text can break the entire layout.

• We recommend you run through this workfl ow yourself before presenting it to 
the class, to help you anticipate any potential questions.

Questions
Th e following questions are not in the student’s Classroom in a Book.

1. What are the benefi ts and limitations to using a master page?

2. How do you change a Swap Image behavior event from being triggered by a 
mouseover to a mouse click?

3. Should the HTML and Images export be used for a fi nal production website? 
Why or why not?

4. How are sublayers helpful?

5. What are the current limitations to sublayers?

6. What steps are required to create a simple rollover eff ect?
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Answers
1. Graphic elements common to the entire design can be kept on a master page. 

So if you need to update those graphics, the editing can be done on the master 
page and the changes will appear on all pages.

Th e main limitations to master pages are that you can only have a single master 
page per fi le, and that the elements on the master page will appear in the same 
physical location on all pages, regardless of an individual page’s dimensions.

2. Select the slice where the behavior has been applied and open the Behaviors 
panel. Choose the appropriate onMouseOver event (there may be more than 
one, depending on the interactivity applied to the slice) and click on the drop-
down menu beside the event name. Select onClick to change the event.

3. HTML and Images export should not be used for a fi nal production website for 
several reasons:

• Table-based layouts are no longer considered best practices.

•  Multiple unnecessary images are exported in order to allow the table to 
display the design. Many images are exact copies of each other, created 
from the other pages in the design.

• All elements in the design are converted to graphics, including text.

•  Editing the resulting HTML can be problematic; for example, deleting a 
graphic slice to replace it with true HTML text can break the entire layout.

4. Sublayers can be a useful tool for structuring a web page design within 
Fireworks. Th e Layer and Sublayer relationship is also maintained as Layer 
groups if the fi le is saved as a Photoshop fi le. Likewise, if a Photoshop fi le is 
opened within Fireworks, any Layer groups are maintained as a Layer/Sublayer 
hierarchy.

5. Sublayers do have limitations, at the moment. When you copy a layer that 
contains sublayers, only the parent layer elements are copied to the clipboard; 
sublayers are ignored.

If you copy a sublayer, only the objects within the sublayer are copied. So if you 
were to paste the clipboard contents into a new design, only the objects—and 
not the actual sublayer that contained them—would be pasted. 

If you share a layer to other pages, all sublayers are automatically shared with that 
page as well. You cannot selectively share certain sublayers with diff erent pages.

6. In order to create a simple rollover eff ect, you must have two states. Each state 
must have a graphic of the same size and in the same location. A slice needs to 
be drawn over the graphic on the fi rst state. Th e behavior, Add Simple Rollover, 
must be applied using the behavior handle of the slice.
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Lesson 12: Improving Your Workfl ow
This chapter is located on the companion disc as a PDF, along with accompa-
nying lesson fi les.

Point out that fi nding ways to speed up common tasks without sacrifi cing quality is 
important to any business. Th e exercises in this lesson will expose students to a few 
ways in which they can use Fireworks to expedite their workfl ow.

Goals for this lesson
In this lesson, they will learn how to do the following:

• Use Bridge to help you locate fi les

• Use the Batch Process command

• Customize the Batch Process

• Add project information to a fi le 

• Set the base optimization setting for multiple pages

• Add Photoshop Live eff ects

• Save as a Photoshop fi le

Getting Started in Adobe Bridge
Point out that Bridge can be a real nerve center for almost all work done with the 
Creative Suite. You can view fi les, sort fi les, stack them into groups, apply keywords 
and—as seen in the next exercise—launch other CS4 applications to run automated 
commands such as batch processing. It’s an application that the team used very 
often during the creation of this book.

For more information on Adobe Bridge, be sure to check out adobe.com.

Batch processing and customizing using Bridge and
Fireworks
Batch processing is a very powerful tool in Fireworks. Bridge makes it even more pow-
erful because the user can view fi les fi rst, before selecting them for batch processing.

Take the time to point out the other automated Fireworks features which can be acc-
essed through Bridge, such as Convert to Grayscale and Convert to Sepia Tone, both
of which are applied using Fireworks Live Filters, so they remain completely editable.

While not discussed in the book, point out that running the Batch Processing wiz-
ard gives you access to any command available from the Fireworks command menu, 
including custom commands created by the user. As long as the command does 
not rely on selecting a specifi c object in a fi le, most commands will run successfully 
from the batch processing wizard.
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Cropping individual bitmaps in a design
Th e ability to further crop a bitmap once it has been imported or pasted into an 
existing design is very useful, and this usefulness is demonstrated when the learner 
imports a series of images for a photo gallery, only to fi nd that two of the images 
are a diff erent dimension from the rest.

Exporting a specifi c area
Rather than the current design, the Export Area tool lets you drop a crop. And 
when you commit to the crop, you’re brought to the image preview window where 
you can save the cropped area as a fl attened image that can be e-mailed to a client. 
As demonstrated in the lesson, this workfl ow can be helpful if you want a client to 
focus on a specifi c area of a design.

While not mentioned in this lesson, point out that users also have options to send an 
open design directly to e-mail, either as a Fireworks PNG fi le or a fl attened JPEG fi le.

Future proofi ng your projects
Th e exercises in this part of the lesson focus on making your fi les as useful as pos-
sible to others (in terms of project information) and particularly those who prefer 
to work in Photoshop rather than Fireworks.

Lesson 13 takes this concept even further, with exercises for working with Flash, 
Flex and AIR.

Adding metadata
Point out that metadata can be added either through Bridge or through the File > 
File Info menu. At the very least, adding some keywords to each fi le worked on can 
greatly speed up searching for fi les at a later time.

Using Photoshop Live Eff ects
Photoshop Live Eff ects were present in Fireworks CS3 as well as the current CS4 
version. Nothing has really changed in this area, but it’s worth pointing out that 
support for Photoshop Layer Styles (Live Eff ects in Fireworks) makes it easy to 
maintain certain eff ects when a PSD fi le is opened within Fireworks. Likewise, if it 
is known that an original Fireworks design is destined to be edited in Photoshop, 
using Photoshop Live Eff ects guarantees that those eff ects will remain editable 
within Photoshop.

Th e Live Eff ect used in the exercise —Stroke —is unique in that Fireworks has no 
native counterpart to it. Regular or masked bitmaps can have a stroke applied to 
them easily.

Note: �  Creating 
a custom command 
was not specifi cally 
covered in this lesson, 
but you may see a 
learning objective 
listed at the beginning 
of the lesson. Instead, 
we walk the students 
through customizing 
the commands used 
during the Batch 
Process. In the fi nal 
screen for the Batch 
Process Wizard, the user 
has the option to Save 
Script that would add 
the customized batch 
process to the Fireworks 
Commands menu as 
a custom command. 
In many cases, custom 
commands are created 
by selecting a series 
of steps in the History 
panel and choosing 
Save steps as a 
Command.
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Saving as a Photoshop fi le and customizing Photoshop 
export options
Just as you can customize how a Photoshop fi le is imported or opened within 
Fireworks, you can also control the options for saving any design within Fireworks 
as a Photoshop fi le. 

Th is is an important feature because Photoshop does not recognize the enhanced 
PNG format used by Fireworks. If a Fireworks PNG fi le is opened within 
Photoshop, the entire design is fl attened into a single bitmap image.

Also point out that only solid color fi lls within vectors are maintained if you choose 
to retain the editability of vector objects. Th e only ways around this are to choose 
Maintain Fireworks Eff ects from the save options (this will rasterize all vector 
objects, including text), or by choosing custom and selecting Maintain appearance 
for vector category (text will not be rasterized, but all vectors will be converted to 
bitmaps).

Common blending modes and Live Filters
Th e charts in this section also highlight the integration between Photoshop and 
Fireworks. Th ere is a fair amount of common ground between the two applications, 
and knowing what elements are supported in both can help a user maximize this 
compatibility.

Questions
Th e following questions are not in the student’s Classroom in a Book.

1. How do you set the base optimization setting for multiple pages?

2. Where are Photoshop Live Eff ects located?

3. What is the equivalent to Photoshop Live Eff ects within Photoshop itself?

4. How do you convert a Fireworks design into a Photoshop fi le? 

5. What are some of the limitations of converting a Fireworks PNG fi le to a 
Photoshop fi le?

Answers
1. You can set a common or base optimization by fi rst selecting the pages in the 

Pages panel. Hold Shift to select a continuous series of pages or hold down the 
Ctrl (Windows) or Command (Mac) key to select specifi c pages not in sequence. 
Th en choose the Export format from either the Property inspector or the 
Optimize panel.

2. Photoshop Live Eff ects are located in the Live Filters menu in the Property 
inspector.
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3. Photoshop Live Eff ects are called Layer Styles in Photoshop. While these eff ects 
are maintained and can be activated from within Fireworks, Th e Layer Styles 
panel within Photoshop is much more robust, giving many more creative 
options.

4. Select File > Save As and choose Photoshop PSD (*psd) from the Save copy as 
fi eld.

5. Photoshop does not support multiple pages, so you must save a multi-page PNG 
fi le as a separate PSD fi le. Vectors containing gradient, texture or pattern fi lls 
will have the fi ll discarded when saved as a PSD fi le.

Lesson 13: Going Further
This chapter is located on the companion disc as a PDF, along with accompa-
nying lesson fi les.

As the heading indicates, this supplemental lesson will take the learner beyond the 
basics. Th ey will get a more rounded picture of how Fireworks fi ts into a variety of 
workfl ows: Fireworks to Dreamweaver, Fireworks to Flash, AIR and Flex.

Goals for this lesson
In this lesson, they will learn how to do the following:

• Use blending modes to correct images 

• Apply AIR event commands to slices and hotspots

• Create an AIR prototype for client review 

• Customize a Flex skin for use in an AIR application

• Use Fireworks and Dreamweaver together

• Create graphics for fi xed and fl uid web-page containers

• Work with native Fireworks PNG fi les in Flash

Interaction review
As in the previous two lessons, we encourage you to review the completed project 
so that students gain a sense of what they are aiming for, prior to building on the 
AIR prototype. After the review, students will build on a starting version of the 
prototype.

Creative and corrective techniques
Techniques for image correction and for working with vector strokes are demon-
strated in this section.
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Blending modes for image correction
Working with a combination of blending modes and Live Filters can improve the 
quality of an image in simple and non-destructive manner. Take some time to defi ne 
Blending modes and show examples other than the one demonstrated in this book.

Important Note: Th is section contains a workfl ow error. Th e section on turning 
two blended images into a symbol will not work as described in the text. When 
you combine blended images into a symbol, the blending mode is removed. A new 
workfl ow, beginning with Step 10 in this exercise, has been posted as errata:

http://www.peachpit.com/store/product.aspx?isbn=0321612191

Working with AIR
Fireworks is not just for prototyping websites. Th is set of detailed exercises 
on building an AIR prototype discusses in brief what AIR is and shows how 
Fireworks can save the development team a lot of time, just as it can with website 
development. 

Point out that the same type of interactivity available to a website prototype is also 
available when building and AIR prototypes, but with the added features of being 
able to drag, close, minimize and maximize the application prototype on the desk-
top, using graphic elements within the application itself.

Emphasize that Fireworks only creates a prototype; Firework cannot connect to 
databases or update anything within the prototype dynamically. All states of the 
prototype must be planned out and built graphically.

Students will build on the design they started with Lesson 13, adding virtually all 
the interactivity to make the prototype function. 

Creating an AIR prototype
For a simple command, a lot happens when this menu option is chosen. Students 
will walk through all the settings for the Create AIR package dialog window. Point 
out that a great deal of the information in this dialog is required.

To minimize any errors when creating the digital signature, please make sure all 
computers have the latest version of AIR installed.

Point out that while not indicated in the dialog box, ALL fi elds must be fi lled out 
when users create their digital signature.

Installing the prototype
Installing an AIR prototype is a breeze if the package was created correctly. To add 
a sense of completion, though, we recommend you allow students to install their 
prototype, if possible. 
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You should test this process beforehand, logged onto a computer as a student; lab 
computers may not have the necessary rights to allow for the installation and you 
may have to talk with your tech support staff  to see if any arrangements can be made.

During installation, the user can choose where the prototype should be installed. 
We recommend the Lesson13 folder, so that the fi les can easily be deleted 
afterwards.

Creating a Flex skin
Before proceeding with this exercise, you should take a few minutes to explain to 
students what Flex is. Th e basic description from Adobe is as follows:

Adobe® Flex® is a cross platform, open source framework for creating rich Internet 
applications that run identically in all major browsers and operating systems, and 
now on the desktop with Adobe AIR™.

We recommend visiting the Flex Developer Center ahead of time (http://www.
adobe.com/devnet/fl ex/) to locate a couple of examples to show the class. As this 
exercise indicates, the Nature console prototype could be coded into a true applica-
tion using Flex.

Point out that from the designer’s perspective, they do not need to understand 
how to create applications in Flex, but in such a case, discussions with the Flex 
programmer are strongly recommended. A good rapport between designer and 
programmer creates a much smoother project fl ow. 

For the purposes of this section in the lesson, students will see how the designer 
(and Fireworks) fi t in with the development team, by bringing his or her visual 
skills to bear on the creation of assets for a Flex application. 

In this section, students will learn how to customize the skin (the graphics) for 
a specifi c component (a button), how to add additional states to the button, and 
how to export the graphics so the programmer can incorporate them into the 
application.

Fireworks and Dreamweaver
Fireworks and Dreamweaver have shared a long history together. Th is series of 
exercises demonstrates to the students how this integration can improve their 
workfl ow.

Copying and pasting to Dreamweaver is pretty self-explanatory. You may want to 
point out that this functionality is also available for Photoshop and Dreamweaver, 
and that the same Image Preview window (a Fireworks feature) is used to allow the 
conversion and pasting of Photoshop fi les or layers into Dreamweaver.

Round trip editing with Dreamweaver is a feature that has been with Fireworks since 
the beginning and as such is useful only for Fireworks prototypes that have been 



48 INSTRUCTOR NOTES

exported as HTML and Images. Th e workfl ow relies on the table-structure of the 
HTML document matching the layout of the Fireworks PNG fi le. As a result, this 
workfl ow cannot be used reliably if the user exports their design as CSS and Images.

Th e three-slice technique is a method for creating an expandable container for web 
page content. It’s a very common design element in a web page and typically the 
box has rounded corners.

Th is exercise has the students go through the process of creating the slices neces-
sary for the container, but does not go into detail regarding how the slices are 
applied to a web page using CSS. You may want to prepare some assets ahead 
of time, so that the students can go from Fireworks to Dreamweaver. While the 
technique is a staple skill for a web designer, it is not considered a basic or intro-
ductory-level exercise.

Fireworks and Flash
With its robust bitmap and vector toolset, Fireworks can be a great starting point 
for designing graphics for a Flash animation or interface. Point out that a layered 
Fireworks PNG fi le can be imported into Flash, as well as fl at fi les such as JPEG or GIF.

Flash will maintain the layer hierarchy of a native Fireworks PNG fi le as well as a 
variety of eff ects, but some Fireworks features are not supported in Flash. Th e com-
mon eff ects and blending modes are listed in two separate tables in this lesson.

If the user needs to make edits to a native Fireworks PNG fi le that has been 
imported into Flash, they will have to return to Fireworks, edit and save the fi le, 
then re-import the PNG fi le into Flash. Th ere is no round-trip workfl ow for a native 
Fireworks PNG fi le. While this may seem limiting, remind students that they have 
access to all the layers and objects directly within Flash. Fireworks vector objects, 
for example, remain completely editable with Flash.

However, round-trip editing is available when a fl attened image fi le is imported 
into Fireworks. If that fl attened fi le was created from a Fireworks PNG fi le, the user 
can edit the PNG directly in Fireworks, click done and both the PNG fi le and the 
fl attened asset in Flash are updated.

Questions
Th e following questions are not in the student’s Classroom in a Book.

1. How does importing a multilayered Fireworks PNG into Flash diff er from 
importing a fl attened image?

2. How do you round trip edit a bitmap image from Flash to Fireworks?

3. When should you not use round trip editing between Dreamweaver and 
Fireworks?
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4. When round trip editing from Flash or Dreamweaver, what is the best format to 
pick if available?

5. How do you ensure that the background of an AIR prototype does not display 
when running the prototype as an AIR application?

Answers
1. Importing a native Fireworks PNG fi le into Flash gives you the most control 

over the fi le. All layers and objects are retained as separate elements, vectors and 
text remain editable and some Fireworks eff ects can also altered while in Flash. 
Importing a fl attened bitmap gives you the ability to round trip edit the bitmap 
using Fireworks. If the bitmap was created from a native PNG fi le, you can 
choose to open the PNG fi le in Fireworks for non-destructive editing of the fi le.

2. To launch round trip editing in Flash, right-click (Windows) or Control-click (Mac) 
the image in the Library panel and then choose Edit With Fireworks. Th e Find 
Source dialog box will appear and you will be asked if you want to edit this image 
directly, or locate a PNG fi le to make the edits. When you are fi nished editing in 
Fireworks, click the Done button to save the fi le and update it within Flash.

3. If you web page design is laid out using CSS rather than tables, round trip 
editing from Dreamweaver to Fireworks will produce undesirable results in the 
updated web page.

4. If available, choose the original native PNG fi le for round trip editing. Th is gives 
you the most non-destructive fl exibility in editing the design.

5. In order to ensure a transparent background in your fi nal functioning AIR 
prototype, make sure that the entire fi le is optimized as PNG 32. In the Create 
AIR package dialog box, make sure the Window option is set to transparent, 
and add 5 pixels to the height and width of the window to eliminate scroll bars.


